DEVELOPMENT OF THE THIN-WALL-2 PROGRAM FOR
BUCKLING ANALYSIS OF THIN-WALLED SECTIONS
UNDER GENERALISED LOADING

Van Vinh Nguyen*, Gregory J. Hancock* and Cao Hung Pham*

* School of Civil Engineering, The University of Sydney, Australia
e-mails: vanvinh.nguyen@sydney.edu.au, gregory.hancock@sydney.edu.au, caohung.pham@sydney.edu.au

Keywords: Thin-walled sections, generalised loading, localised load, buckling analysis, Semi-Analytical Finite Strip Method, THIN-WALL-2.

Abstract. The Semi-Analytical Finite Strip Method (SAFSM) of buckling analysis for thin-walled sections has been recently extended from bending and compression to shear and localised loading. A new computer program called THIN-WALL-2 has been recently developed at the University of Sydney using a MATLAB graphical interface and Visual Studio C++ computational engines. This paper describes the development of the MATLAB graphical interfaces including localised loading and shear. For localised loading, a linear pre-buckling analysis is required to determine the membrane stresses for use in the buckling analysis. The program includes output of these membrane stresses and deformed shapes as well as buckling modes determined from these stresses.

1 INTRODUCTION

The development of the Direct Strength Method (DSM) of Design of Cold-Formed Sections as specified in the North American Specification NAS S100:2012 [1] and the Australian/New Zealand Standard AS/NZS 4600:2005 [2] requires the ability to compute the elastic buckling loads of thin-walled sections including overall (Euler), distortional and local modes. The computer programs most commonly used in North America, and Australia and New Zealand are CUFSM [3] and THIN-WALL [4]. They are based on the Semi-Analytical Finite Strip Method (SAFSM) of analysis developed by YK Cheung [5] and then applied to the buckling of thin-walled sections under compression and bending by Plank and Wittrick [6]. An alternative approach based on Generalised Beam Theory (GBT) has been recently developed by D. Camotim and his colleagues in the program namely GBTUL [7]. The latest version of this program (GBTUL 2.0) allows for arbitrary cross-sections, and arbitrary loadings.

In 2012, the North American Specification NAS S100:2102 included the DSM for shear, and combined bending and shear. This necessitates the ability to compute the buckling loads of thin-walled sections in shear. Hancock and Pham [8] further developed the SAFSM using the complex number mathematics by Plank and Wittrick [6]. It was then used to investigate shear buckling of channel sections with longitudinal stiffeners by Pham, Pham and Hancock [9]. As the nodal lines in a shear buckle are not perpendicular to the section due to the phase shift in the buckling mode across a section, the constraints at two simply supported ends increase the buckling load and change the mode as described in Hancock and Pham [10]. Further, generalised loading from arbitrary distributed and point loads along a structural member may cause localised buckling in the form of web crippling. A recent SAFSM buckling analysis for this case has been developed and described by Hancock and Pham [11]. The main purpose of this paper is to describe the computer program namely THIN-WALL-2.
extended from the earlier THIN-WALL program to include shear loading and arbitrary localised loading. As the generalised loading results in non-uniform stresses which are not included in CUFSM and THIN-WALL, then a pre-buckling analysis is required to determine the stress distributions in the section. This has been included in THIN-WALL-2.

2 SEMI-ANALYTICAL FINITE STRIP METHOD-BRIEF OVERVIEW

The SAFSM analysis implemented in the version of THIN-WALL-2 described in this paper uses two different versions of the SAFSM buckling analysis. The first is \texttt{bfinst7.cpp}[8] for uniform loading which uses complex mathematical functions with no end constraints and so shear modes and the signature curve associated with shear are included as well as those associated with bending and compression. The second is \texttt{bfinst10.cpp}[11] for localised loading which assumes simply supported end boundary conditions and arbitrary loading. The theory including displacement functions used in the buckling analyses is described in detail in a separate paper at this conference (Hancock and Pham [12]).

Extension of \texttt{bfinst10.cpp} to other than simply supported boundary conditions is under current development and will be included in the next version of THIN-WALL-2.

3 THE THIN-WALL-2 V1.0 PROGRAM OUTLINE

3.1 Domain of Application

The THIN-WALL-2 program is written to define input data using a Graphic User Interface (GUI) to perform pre-buckling and buckling analyses of thin-walled sections under generalised loading. The loading may contain uniform loading and localised loading. The GUI is then used to display the results of the analyses.

It is also possible to use this program to perform a cross-section analysis to generate the section properties. The cross-sections can be formed from different shapes includes open and closed sections or mixed sections.

3.2 Code Structure

The THIN-WALL-2 program contains the GUI which calls two programs: \texttt{bfinst7.cpp} and \texttt{bfinst10.cpp} which are written by using C++ computer language. The \texttt{bfinst7.cpp} program as described in [9], [12] is used in a Uniform Loading module where the main functions are a cross-section analysis, a stress analysis and a buckling analysis of thin-walled sections under uniform loading. The \texttt{bfinst10.cpp} program is used in a Localised Loading module for both pre-buckling and buckling analyses of thin-walled sections under localised loading as described in [11].

The program sequence in THIN-WALL-2 is shown in Fig.1. In the first step, the user defines the input data such as materials, element types, sections and the restraints. The second step includes two types of analysis of a structural member under loads. The first type is the analysis of a structural member under uniform loading. In this case, the user defines the half-wavelengths and assign the uniform loads such as compression, bending and shear before running the section analysis, the stress analysis and the buckling analysis. The second type is the analysis of a structural member under localised loading. The user defines the series terms number, the boundary conditions and assign the localised loading before running the pre-buckling analysis and the buckling analysis. In the final step, the results from the analyses are displayed on the main window of THIN-WALL-2 and exported into different data files.
3.3 Comparison with the previous THIN-WALL program

The THIN-WALL-2 program is developed by expanding the functions of the THIN-WALL program [4]. This expansion refers to the extension of THIN-WALL-2 to pre-buckling and buckling analyses of thin-walled sections under generalised loading such as uniform loading or localised loading compared to only uniform compression and bending in THIN-WALL. In addition, the new version improves the quality of some features related to the graphic interface.

Table 1 shows the comparison between two programs, making it possible to assess the new developments.
<table>
<thead>
<tr>
<th>Features</th>
<th>THIN-WALL</th>
<th>THIN-WALL-2 V1.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Limited number of materials</td>
<td>Unlimited number of materials</td>
</tr>
<tr>
<td></td>
<td>Isotropic material</td>
<td>Isotropic material</td>
</tr>
<tr>
<td></td>
<td>Corrugated webs</td>
<td></td>
</tr>
<tr>
<td>Element type</td>
<td>One element type</td>
<td>Many element types</td>
</tr>
<tr>
<td>Cross-section geometry</td>
<td>Default and general section types</td>
<td>Default and general section types</td>
</tr>
<tr>
<td>Boundary condition</td>
<td>One “standard” of end supports (S-S)</td>
<td>2 “standards” of end supports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Free to deform for uniform loading and Simply supported (S-S) for localised loading)</td>
</tr>
<tr>
<td>Restraint</td>
<td>Restraint by X,Y,Z directions and rotation by Z axis</td>
<td>Restraint by X,Y,Z axes and rotation by Z axis</td>
</tr>
<tr>
<td>Loading</td>
<td>Uniform compression (N) and bending (M)</td>
<td>Uniform compression (N), bending (M), shear (V) or localised loading</td>
</tr>
<tr>
<td>Analysis</td>
<td>Cross-section analysis</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Pre-Buckling analysis</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Buckling analysis</td>
<td>Available</td>
</tr>
<tr>
<td>Results</td>
<td>Deformation modes</td>
<td>One section</td>
</tr>
<tr>
<td></td>
<td>Deformation shapes</td>
<td>All sections</td>
</tr>
<tr>
<td></td>
<td>Stress</td>
<td>$\sigma_x$ stress due to N or M</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$\sigma_x$, $\sigma_y$ and $\tau_{xy}$ stresses due to N, M, V and localised loading</td>
</tr>
<tr>
<td>Support</td>
<td>Export data and report</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Tutorial</td>
<td>Available</td>
</tr>
<tr>
<td>Other</td>
<td>Cross-section templates</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>General section</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Save/load data</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Changing font style</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Output files type</td>
<td>*.txt (text file)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*.txt and *.xls files (text and excel files)</td>
</tr>
</tbody>
</table>

### 4 THE THIN-WALL-2 PROGRAM, DETAILED DESCRIPTION

#### 4.1 General

There are 11 menus which are created in THIN-WALL-2 as shown in Fig.2. Each menu has different functions which help the user to manage the analyses effectively. The user can select these menus step by step following the analyses. In addition, there are some short cut buttons on the main window which have the same functions with selection from the menus, thus it is easier for the user to run the program.

![Figure 2: Program menus](image)
4.2 File Menu

The main function of the File menu is to manage the data during the running process of THIN-WALL-2. The user can create a new folder which includes all of the data files for each project. During the running process, data files are created in the main folder of THIN-WALL-2 to provide support for the analytical steps. When the user closes the project, all data files are moved from the THIN-WALL-2 folder to the new folder which the user has created. In addition, the user can open an old project and continue with a previous job. In this stage, all data files are moved from the old folder to the THIN-WALL-2 folder and used during the analytical steps. With this feature, the user can manage and save the data files easily and use them for different purposes.

4.3 Edit Menu

The Edit menu is designed with the main function of supporting the user in managing objects during the analytical processes. The user can copy, cut and paste the input and the output data from other programs such as Microsoft Word, Microsoft Excel or some image software into THIN-WALL-2. Also, these data can be exported from THIN-WALL-2 to other software.

4.4 View Menu

The main function of the View menu is to help the user to control images in the main window. The user can choose 2D view, 3D view, they can also rotate, move, zoom in and zoom out objects to have the best views. In addition, there is a View-Bar designed on the right hand side of the main window which is used to control objects easily by selecting option buttons directly without selection from the menu.

4.5 Format Menu

The Format menu contains selections which the user can use to change the appearance of the program. For example, the user can define and change the units for the whole program by the Units option from the Format menu. The Unit_System window appears as shown in Fig.3 for the user to select the unit of length and the unit of force. After choosing the units and clicking on the OK button, the units are displayed in all relevant dialog boxes and the values which are defined in the previous steps are updated automatically with the new units.

In addition, there are other selections in the Format menu such as fonts, colours, lines, etc which the user can change for objects in the program in order to have the best display solutions.

![Figure 3: Define Units](image-url)
4.6 Define Menu

4.6.1 Define materials

In the first step of the analytical process, the user has to define the materials for the structural member. The THIN-WALL-2 program is designed for isotropic materials with the same values of Young’s modulus and Poisson’s ratio in both the longitudinal and transverse directions.

A steel material is created as the default material, so that if the user agrees with this, then they can click on the OK button to ignore the material definition step. In order to define a new material, the user clicks the Add button, so that a Materials_New window appears to input the material properties as shown in Fig.5(a). There are an unlimited number of materials; therefore, it is easier for the user to analyse structures which are made from more than one material. The materials which have been defined are displayed in a table in the Materials window as shown in Fig.4.

![Figure 4: Define materials](image)

![Figure 5a: Add a new material](image) ![Figure 5b: Modify a material](image)

The user can select the material in the Materials table and click on the Modify button to change the material properties. The Materials_Modify window appears as shown in Fig.5(b) for the user to revise the properties for the selected material. Also, the user can delete any material which they defined by selecting material in the Materials table and clicking on the Delete button.

4.6.2 Define element types

After the material definition step, the user has to define the element types which includes the properties of each strip such as the material, thickness for bending and thickness for shear which are used in the cross-section analysis. Similar to the material definition step, there is an Add button, a Modify button and a Delete button which are used to add new element types,
modify element types or delete element types respectively. For example, when the user clicks on the Add button, the Element_Types_New window appears as shown in Fig.6(b) and the user can select material from the material list which is defined in the material definition step. After that, the user inputs the thickness for bending and the thickness for shear of the new element type. The element types which have been defined are displayed in the Element Types window as shown in Fig.6(a).

4.6.3 Define Sections

4.6.3.1 General

Before a computer analysis of a thin-walled section can be commenced, the geometry of the cross-section must be described to the computer. The method of computer data input is similar to the data for a plane structural framework being analysed on a computer. To achieve this similarity, a thin-walled cross-section should be divided into an assemblage of rectangular elements, with the ends of the elements intersecting at nodes.

The coordinates of the nodes of the cross-section based on an arbitrary axis system (X,Y) are input with the identification number for each node. The rectangular elements of the cross-section are input together with the identification number of the connected nodes. A number of different elements types can be defined, and the effective thickness and elastic moduli in flexure and shear, and Poisson’s ratio for each type are also input. Any elements which form a closed loop must be included in the data for the section. The element number in the loop is preceded by a negative sign if the order of the node numbers which define the ends of the element is opposite to that for a clockwise traverse around the loop.

4.6.3.2 Channel sections

THIN-WALL-2 is designed with three channel section types: an un-lipped channel section, a lipped channel section and a general channel section. Each type has four types of web stiffeners such as plain C, rectangular stiffener, one triangular stiffener and two triangular stiffeners as shown in Fig.7. In this window, the user selects a channel section type and element type in order to assign default properties for the section. The dimensions of the section are overall dimensions but the program changes these dimensions automatically to centre to centre dimensions to calculate the section properties. Also, the user defines the strip subdivision for the section to determine the number of strips and nodes included in the section.

After finishing inputting the dimensions for the section, the user clicks on the Preview button to show the section data. The Section_Data window appears with two main data tables as in Fig.8. The first one is the Node_Data table with the nodal information such as nodal number, nodal co-ordinate. From this table, the user can add new nodes, insert nodes and
delete nodes by clicking on the Add button, the Insert button and the Delete button respectively. The second one is the Strip_Data table which includes the strip number, start node and end node of each strip. The user can change the start node, the end node and reassign the element type for each strip. By clicking on the Apply button, then the section data is updated and shown in the Section Preview panel.

Figure 7: Define a channel section

Figure 8: Section data
4.6.3.3 General sections

Recently, cold-formed steel has been applied with many section types, but some of them have not been created as template sections. In order to define these sections, the user selects the General Sections option from the Define/Sections menu, so that the General Sections window appears as shown in Fig.9 which includes two tables. The first one is the Node_Data table where the user can input the nodal co-ordinates directly. The user can prepare the nodal co-ordinates in an Excel file, then copy and paste into this table. The second one is the Strip_Data table where the user can input the data for the strips. The user can click on the Default button to get the default definition for the Strip_Data table before changing the start node, the end node, and the element type for the strip which the user may want to change. By clicking on the Apply button, then the section data is updated and shown in the Section Preview panel.

![General Sections window](image)

Figure 9: Define a general section

4.7 Assign Menu

4.7.1 Assign restraint

The Restraints window appears as shown in Fig.10 when the user selects the Restraints option from the Assign menu. There is a table which includes the nodal number and the nodal co-ordinates for the user to assign the restraint conditions. There are four degrees of freedom for each node, thus the user can fix the nodal translation such as $D_x$, $D_y$, $D_z$ by X,Y,Z directions and the nodal rotation about the Z axis. By selecting the restraint condition for each node from the table and clicking on the Apply button, the restraint conditions for the whole section are updated and displayed on the Section View. For the analyses of standard sections under localised loading, the user can click on the Default button to apply the lateral restraints at localised loading points as described in 4.7.3.
4.7.2 Assign stress resultants and half-wavelengths for the Uniform Loading module

4.7.2.1 Define half-wavelengths

THIN-WALL was written to analyse a structural member under uniform compression and bending alone over a range of half-wavelengths. Further development has been done for THIN-WALL-2, so that it is possible to perform buckling analyses of a structural member under uniform compression, bending and shear or combinations of them over a range of half-wavelengths using the Uniform Loading module.

Before the definition of stress resultants, the user has to define the half-wavelengths by selecting the Half-wavelengths option from the Assign/Uniform Loading menu. The Half-wavelengths window appears as shown in Fig.11 with forty default half-wavelengths which are displayed on the Half-wavelengths table. The minimum default half-wavelength is 30mm and the maximum default half-wavelength is 10000mm. In addition, the user can define more half-wavelengths, insert new half-wavelengths, modify half-wavelengths or delete half-wavelengths by clicking on the Add button, the Insert button, the Modify button or the Delete button respectively.
4.7.2.2 Assign stress resultants

After the definition of the half-wavelengths, the user selects the Stress Resultants option from the Assign/Uniform Loading menu. The Stress_Resultants window appears for the user to input the axial force, bending moments \( M_x, M_y \), shear forces \( V_x, V_y \), bimoment \( B \), Saint-Venant (uniform) torque and warping (non-uniform) torque as shown in Fig.12.

![Figure 12: Define stress resultants](image)

4.7.3 Assign boundary condition, localised loading and series terms for the Localised Loading module

4.7.3.1 Assign boundary condition

Boundary condition refers to the support condition at the ends of the beam for use in the localised loading analyses using the Localised Loading module. By selecting the Boundary conditions options from the Assign/Localised Loading menu, the Boundary_Conditions window appears as shown in Fig.13. In Version 1.0 of THIN-WALL-2, the boundary condition is assumed both ends simply supported for the structural member under localised loading. This case is set as a default boundary condition with suitable displacement functions for both flexural and membrane displacements. Other boundary conditions will be included in the next version of THIN-WALL-2.

![Figure 13: Define boundary conditions](image)
4.7.3.2 Assign localised transverse loads

There are two localised loading cases as shown in Fig.14: Interior one-flange loading (IOF), Interior two-flange loading (ITF). Other localised loading cases which are End one-flange (EOF) loading and End two-flange (ETF) loading will be included in the next version of THIN-WALL-2.

![Figure 14: Define localised loading](image)

The user selects the Localised Transverse Loads option from the Assign/Localised Loading menu, the Fig.15 appears to define the localised loading. Firstly, the user selects a loading case by clicking on one of the two Load buttons, so that the loading case is displayed in the Load View panel. Secondly, the user inputs the length of the beam (L), the load length (n) and the load position. The user can select the relative assign or the absolute assign to define the position of loading on the beam. In addition, the value of loading must be input into the Load Value panel in the middle of this table. Finally, the user defines the applied loading points by selecting nodes in the Applied Loading Points table on the right side of this window.

![Figure 15: Assign localised loading](image)

4.7.3.3 Assign series terms

In the buckling analysis of a structural member under localised loading, THIN-WALL-2 calls the Localised Loading module [11] to analyse the structure and export the results to data files. In this analysis, the Localised Loading module analyses the structure with multiple
series terms in order to get the most accurate results. Therefore, the user has to define the number of series terms as shown in Fig.16 by selecting the Series Terms option from the Assign/Localised Loading menu. When using more series terms, the user gets more accurate results; however, the program runs longer because there are more degrees of freedom as described in [11].

4.8 Analysis Menu

4.8.1 Cross-section analysis

The Uniform Loading module initially runs a cross-section analysis to achieve the section properties such as section area, moment of area, centroid, shear centre in rectangular axes and principal axes, monosymmetry parameter, torsion and warping constants. In addition, the user can show these section properties on the properties panel, display images of the section properties on the main window and export images to other software as in 4.8.2.

4.8.2 Stress or Pre-buckling Analysis.

The Pre_buckling_Analysis window appears as shown in Fig.17 when the user selects the Stress or Pre-buckling Analysis option from the Analysis menu or the Pre-buckling Analysis button on the Analysis bar. From this window, the user can select the analysis type with suitable loading.
If the user selects the Uniform Loading option, the Uniform Loading module is called to compute the longitudinal and shear stresses for the stress resultants described in 4.7.2.2. The stresses are exported for 21 cross-sections and displayed as in 4.9.3.

If the user selects the Localised Loading option, the Localised Loading module is called to perform a pre-buckling finite strip analysis to compute the deflections and stresses of the structural member under localised loading. The stresses and deflections are exported for 21 cross-sections and displayed as in 4.9.3.

4.8.3 Buckling analysis

The Buckling_Analysis window appears as shown in Fig.20 when the user selects the Buckling Analysis option from the Analysis menu or the Buckling Analysis button on the Analysis bar. From this window, the user can select analysis type with the suitable stresses due to uniform loading or localised loading.

![Buckling Analysis window](image)

The user can select Uniform Loading option or Localised Loading option, THIN-WALL-2 then calls the Uniform Loading module as shown in Fig.19 or the Localised Loading module as shown in Fig.20 to run buckling analyses of the structural member under the membrane stresses. The buckling modes are exported for 21 cross-sections and the buckling modes and shapes are displayed on the main window as in 4.9.4.

![Running the Uniform Loading module](image)
4.9 Results Menu

4.9.1 General

After finishing the analyses, all results of these processes are exported to data files and stored in the main folder of the THIN-WALL-2. Three buttons appear on the tree menu such as the Properties button, the Pre-buckling button and the Buckling button to turn on and turn off the Properties panel, the Pre-buckling panel and the Buckling panel respectively are shown in Fig.21(a),(b),(c). From these panels, the user can display the results on the main window of THIN-WALL-2.
The user has to select the Result Options from the Results menu, so that the Result_Options window appears as shown in Fig.22. From this window, if the user selects the Uniform Loading option, then the GUI reads the data files which are exported from the Uniform Loading module to display on the main window. Alternatively, if the user selects the Localised Loading option, then the GUI reads the data files which are exported from the Localised Loading module.

4.9.2 Section properties

The user can display the section properties after running the section analysis step. The Properties button appears on the tree menu as well as the Properties panel to display the section properties such as section area, moment of area, centroid, shear centre in rectangular and principal axes, torsion and warping constants and monosymmetry parameters as shown in Fig.21(a).

A graphic-bar is designed on the right side of the main window with some special buttons which the user can click on to display section, node number, strip number, restraints, rectangular and principal axes on the main window as shown in Fig.23.
4.9.3 Localised loading pre-buckling analysis results

After running the Pre-buckling analysis of a structural member under localised loading, the Pre-buckling button appears beside the Properties button on the tree menu. By clicking on this button, the Pre-buckling panel appears on this menu with two display options which are deflection and stress as shown in Fig.21(b). If the user chooses the Deflection option, two panels appear for the user to select 2D or 3D views and undeformed or deformed views. The deflection modes and shapes of the structural member are displayed on the main window as shown in Fig.24. In the section option panel, the user can change the section displayed or scale the deflection of the sections.

![Pre-buckling deformation in 2D and 3D views](image)

If the Stress option is selected, the stress panel appears for the user to select stress types such as longitudinal stress ($\sigma_x$), transverse stress ($\sigma_y$) or shear stress ($T_{xy}$). Also, the user can select display or un-display stress values and legends for each diagram on the main window as shown in Fig.25.

![Stress diagrams](image)

Longitudinal (0.5L), Transverse (0.5L) and Shear Stresses (0.45L)

![Stress values](image)
4.9.4 Localised loading buckling analysis results

After running the buckling analysis of a structural member under localised loading, the Buckling button appears beside the Pre-buckling button on the tree menu. When the user clicks on this button, the Buckling panel appears with two display options which are Buckling Mode and Buckling Load as shown in Fig.21(c).

If the Buckling Mode option is selected, the View panel and Deformation panel appear to select 2D or 3D views and un-deformed or deformed views. The buckling modes and shapes of the structural member are displayed on the main window as shown in Fig.26. When the user selects the Buckling Load option, the Buckling_Loads window appears with the information about applied loads, buckling factor and buckling loads.

![Buckling modes in 2D and 3D views](image)

Figure 26: Buckling modes in 2D and 3D views

4.9.5 Uniform loading buckling analysis results

In the buckling analysis of a structural member under uniform compression, bending and shear, the Buckling panel appears with two display options which are buckling mode and signature curve. If the Buckling Mode option is selected, the View panel and Deformation panel appear to select 2D or 3D views and undeformed or deformed views. If the Signature Curve option is selected, the Signature_Curve window appears with some other display options. The user can display the signature curve, buckling modes and buckled shapes together on this window. The signature curve illustrates the relationship between buckling load factors and half-wavelengths as shown in Fig.27.

![Signature curve](image)

Figure 27: Signature curve
4.10 Report Menu

The Report menu is designed to write a report of the analyses. The user can create a full report which contains the input data, the output data and the results of the analyses. Also, the user can export the data files into different files such as text files, excel files and image files. Especially, when exporting to image files, there is a new window where the user can control the images with different colors, view-points before saving them in different formats.

4.11 Help Menu

4.11.1 Introduction about the Semi-Analytical Finite Strip Method

THIN-WALL-2 is written by relying on the theory of the Semi-Analytical Finite Strip Method [5], [6], [8], [9], [10] and [11], thus it is necessary for the user to understand this theory. This function provides a brief introduction as well as advantages and disadvantages and the application of this method. In addition, some links are shown in this module which helps the user to find useful references.

4.11.2 Tutorial

There are some instructional files included in this module as well as a video which the user can download directly to study how to use THIN-WALL-2. Also, if there is any problem, the user can contact the authors to gain support and the best solutions.

4.12 Tool Bars

In order to support the user in using THIN-WALL-2, there are tool-bars which are created on the main window. The first one is the definition tool-bar where the main functions are defining materials, element types and sections. The second one is the assignment tool-bar which is used to assign boundary condition, loadings and restraint. The analysis tool-bar contains the cross-section analysis button, the buckling analysis button and the un-lock and lock buttons. The user can click on these buttons to control the analyses. The result tool-bar is used to display the results of the analyses. Also, the user can export results into other format of data files in order to use for different purposes. The final one is the graphic tool-bar which is located on the right side of the main window. The user can click on buttons from this bar to display images on the main screen such as section, node number, strip number, buckling modes and shapes, signature curve, etc.

5 CONCLUSIONS

This paper provides a presentation of the THIN-WALL-2 V1.0 program which is based on the Semi-Analytical Finite Strip Method [5], [6], [8], [9], [10] and [11]. This second release extends the domain of application of the first one THIN-WALL [4]. It is possible to use this program to analyse a structural member under uniform compression, bending and shear or localised loading. The structural member may be made from both isotropic and orthotropic materials. In addition, with the general section module, THIN-WALL-2 may be used to define and analyse all types of sections such as open sections, closed sections and mixed sections.

In the buckling analysis of a structural member under localised loading, the boundary condition is assumed simply supported at both ends of the beam for Version 1.0. Other boundary conditions will be included in future revisions of THIN-WALL-2.

Finally, the GUI module which is included in THIN-WALL-2 shows an improvement of this program in displaying the results from the analyses. The buckling modes and shapes are displayed in both 2D and 3D views, thus the user can understand the working of the structural member clearly.
6 ACKNOWLEDGMENTS

Funding provided by the Australian Research Council Discovery Project Grant DP110103948 has been used to perform this project.

7 REFERENCES


[7] Bebiano, R., Camotim, D. and Goncalves, R., GBTUL 2.0 – A New/Improved Version of the GBT Based Code for Buckling Analysis of Cold-Formed Steel Members, Proceedings 22nd International Specialty Conference on Cold-Formed Steel Design and Construction (Eds. LaBoube and Yu), St Louis, Missouri, USA, pp 1-19, Nov 2014.

[8] Hancock, G.J. and Pham, C.H. “Direct Strength Method of Design for Shear of Cold-Formed Channel Sections based on a Shear Signature Curve ”, Proceedings, 21st International Specialty Conference on Cold-Formed Steel Structures (Eds. LaBoube and Yu), St Louis, Missouri, USA, pp 207 – 221, Oct 2012.


